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NI 9237 Calibration Procedure

This document contains information about calibrating National
Instruments 9237 modules using NI-DAQmzx. This calibration procedure is
intended for metrology labs.

This document does not discuss programming techniques or compiler
configuration. The NI-DAQmx driver contains online help files that have
compiler-specific instructions and detailed function explanations. You can
install these help files when you install NI-DAQmx on the calibration

computer.
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Conventions

»

bold

italic

monospace

monospace italic

Software

The following conventions appear in this manual:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names and hardware labels.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Monospace text denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

Ttalic text in this font denotes text that is a placeholder for a word or value
that you must supply.

Install NI-DAQmx 8.1 or later on the calibration computer. NI-DAQmx
includes high-level function calls to simplify the task of writing software to
calibrate devices. You must have the proper device driver installed on the
calibration system before calibrating the device.

@ Note NI recommends that you install the NI-DAQmx driver software before physically
installing the NI 9237. NI-DAQmx, available at ni . com/downloads, configures and
controls the NI 9237.

NI 9237 Calibration Procedure

NI-DAQmx supports a number of programming languages, including
LabVIEW, LabWindows™/CVI™, Microsoft Visual C++ 6.0, Microsoft
Visual Basic 6.0, Microsoft .NET, and Borland C++.

You can access the NI-DAQmx header file, NIDAQmx . h, like any standard
library. You can find examples of how to use the NI-DAQmx driver in the
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Program Files\National Instruments\NI-DAQ\Examples
directory.

Documentation

You might find the following documentation helpful as you write the
calibration procedure:

NI-DAQmx Help—This help file contains general information about
measurement concepts, key NI-DAQmzx concepts, and common
applications that apply to all programming environments. To access
this help file, select Start»All Programs»National Instruments»
NI-DAQ»NI-DAQmx Help.

NI-DAQmx C Reference Help—This help file contains C reference and
general information about measurement concepts. To access this help
file, select Start»All Programs»National Instruments»NI-DAQ»
NI-DAQmx C Reference Help.

DAQ Getting Started Guide for NI-DAQ 8.0 or later—This guide
describes how to install NI-DAQmx for Windows software and
NI-DAQmzx-supported DAQ devices, and how to confirm that your
device is operating properly. To access this guide, select Start»
All Programs»National Instruments»NI-DAQ»DAQ Getting
Started Guide.

Note The documents above are installed with NI-DAQmx. You can also download the
latest versions from the NI Web site at ni . com/manuals.

NI 9237 Operating Instructions—This document describes how to use
the NI 9237 and includes specifications and terminal assignments for
the NI 9237. You can download the latest version of this document
from the NI Web site at ni . com/manuals.

Calibration Interval

The NI 9237 should be calibrated at a regular interval as defined by

the measurement accuracy requirements of your application. National
Instruments recommends that you routinely perform a complete calibration
at least once every year. You can shorten this interval based on the accuracy
demands of your application or requirements of your processes. Adjusting
the calibration constants must be done by a factory calibration at NI.

© National Instruments Corporation
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Test Equipment

National Instruments recommends that you use the following equipment
for calibrating the NI 9237.

Table 1. Recommended Equipment

Equipment Recommended Model Requirements

Calibrator Fluke 5700A If this instrument is unavailable, use a
high-precision voltage source with an
accuracy of at least 10 ppm and an
output impedance of less than or equal
to 50 Q.

DMM NI 4070 DMM If this instrument is unavailable, use a
multiranging 6 Y2 digit DMM with an
accuracy of at least 40 ppm.

Chassis NI cDAQ-9172 —

Connection accessories

RJ-50, RJ-50 cable Use an RJ-50 10-position connector
plug and an RJ-50 cable.

Bridge completion
accessories

NI 9949, 350 Q resistors Use one NI 9949 screw terminal
accessory and two 350 € resistors with
at least 1% tolerance.

Test Conditions

NI 9237 Calibration Procedure

Follow these guidelines to optimize the connections and the environment:

Keep connections to the device as short as possible. Long cables and
wires act as antennae, picking up extra noise that can affect
measurements.

Use shielded copper wire for all cable connections to the device.
Use twisted-pair wire to eliminate noise and thermal offsets.

Maintain an ambient temperature of 23 +10 °C. The device
temperature will be greater than the ambient temperature.

Keep relative humidity below 80%.

Allow a warm-up time of at least 10 minutes to ensure that the
measurement circuitry is at a stable operating temperature.
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Calibration Procedure

This section provides instructions for verifying the performance of the
NI 9237.

Calibration Process Overview

The calibration process consists of the following steps:

1.
2.

Initial Setup—Configure the device in NI-DAQmx.

Verification Procedure—Verify the existing operation of the device.
This step confirms whether the device was operating within its
specified range prior to calibration.

Adjustment—Submit the device to NI for a factory calibration to adjust
the calibration constants.

Verification Procedure—Perform another verification to ensure that
the device operates within its specifications after adjustment.

The first two steps are explained in the following sections.

Initial Setup

You must configure the device in Measurement & Automation Explorer
(MAX) to communicate with NI-DAQmx.

Complete the following steps to configure a device in MAX.

1.
2.

Install the NI-DAQmx driver software.

Make sure that no power is connected to the module terminals. If the
system is in a nonhazardous location, the chassis power can be on
when you install the module.

Insert the module into an available slot in the cDAQ-9172 chassis.
Launch MAX.

Right-click the device name and select Self-Test to ensure that the
device is working properly.

@ Note When a device is configured with MAX, itis assigned a device name. Each function
call uses this device name to determine which DAQ device to calibrate. This document uses
dev1 to refer to the device name. In the following procedures, use the device name as it

appears in MAX.

© National Instruments Corporation
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Verification Procedure

Verification determines how well the device is meeting its specifications.
By completing this procedure, you can see how the device has drifted over
time, which helps you determine the appropriate calibration interval for
your application. Table 4 in the Test Limits section shows all acceptable
settings for the device type. Throughout the verification process, use
Table 4 to determine if the device is operating within its specified range.
You must perform verification on all analog input channels.

NI 9237 Calibration Procedure

Complete the following steps to test the performance of the device.

1. Make the following connections on the NI 9949 terminal block:

Insert one leg of each 350 Q resistor into Al-.

Insert the second leg of one 350 Q resistor into EX+.
Insert the second leg of the other 350 Q resistor into EX—.
Connect RS+ to EX+.

Connect RS- to EX-.

Connect the positive input of the DMM to RS+.

Connect the negative input of the DMM to RS—.

Connect the positive output of the calibrator to Al+.
Connect the negative output of the calibrator to Al-.
Leave the SC, T+, and T— terminals unconnected.

If the calibrator has a separate guard connection not connected to
LO, connect that terminal to Al-.

Refer to Table 2 for the pin assignments and signal names of the NI 9237.
Refer to Figure 1 for an illustration of the NI 9949 connections.
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Table 2. Pin Assignments and Signal Names

Module RJ-50 Pin Signal Name Signal Description
1 SC Shunt calibration
2 Al+ Positive analog input
3 Al- Negative analog input

- 4 RS+ Positive remote sense input

) 5 RS- Negative remote sense input

6 EX+ Positive excitation output™
7 EX- Negative excitation output®
8 T+ TEDS DATA
9 T- TEDS Return”
10 SC Shunt calibration

* These signals are shared by all four RJ-50 connectors on the NI 9237.

EX+
RS+

Calibrator

Al+ CJ:)DMM

RS-
EX-

Figure 1. NI 9949 Connections
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2. Set the calibrator voltage to the Calibrator Output value indicated in
Table 4. NI recommends that you verify all values, although you can
save time by verifying only the values used in your application.

3. Ifyouuse C function calls, create a task using DAQmxCreateTask, as
shown in the following table. If you use LabVIEW, skip this step. The
task is created in step 4 in LabVIEW.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCreateTask with
the following parameters:

LabVIEW does not require this step. taskName:

AlVerificationTask
taskHandle: staskHandle

NI 9237 Calibration Procedure 8 ni.com



4. Create and configure an AI Custom Voltage with Excitation channel
using the DAQmx Create Virtual Channel VI, as shown in the
following table. Use Table 4 to determine the minimum and maximum
values for the device.

E Note Throughout the procedure, refer to the NI-DAQmx function parameters for the
LabVIEW input values.

LabVIEW Block Diagram NI-DAQmx Function Call

Call
DAQmxCreateAIVoltageChan
WithExcit with the following

I:default p parameters:
— taskHandle: taskHandle
kask out physicalChannel: dev1/ai0
| kLD nameToAssignToChannel:
— myVoltageChannel
L use Excikation terminalConfig:
For scaling
o [r———  TES DAQmx_Val_Cfg Default
I A minVal: -0.025
- |.ﬁ.I Cuskorn Yaolkage with Excitation "’" rrar out maxVal: 0.025
g Lt units: DAQmx_Val_Volts
=2 bridgeConfig:
DAQmx_Val_FullBridge
feoltage excitation value] voltageExcitSource:
.

DAQmx_Val_Internal
voltageExcitVal:* 2.5, 3.3,
5.0,0r10.0
useExcitforScaling: TRUE
customScaleName: NULL

*Use the excitation value that corresponds to the calibrator voltage value you set in step 2. Refer to Table 4 for corresponding
excitation setting and calibrator output values.
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5. Configure the timing properties for the voltage acquisition using the
DAQmx Timing VI, as shown in the following table.

LabVIEW Block Diagram NI-DAQmzx Function Call

Call DAQmxCfgSampClkTiming
with the following parameters:

taskHandle: taskHandle
source: NULL

rate: 50000
activeEdge:
0 kask ouk .
T DAQmx_Val_Rising
v sampleMode:
= DAQmx_Val_FiniteSamps
[Sample Clock | L_ beot sampsPerChan: 10000
[Satk
6. Start the acquisition using the DAQmx Start Task VI, as shown in the
following table.
LabVIEW Block Diagram NI-DAQmx Function Call
Call DAQmxStartTask with the
kask ouk following parameter:
Lo > Lo taskHandle: taskHandle
{5 ====-=-L‘
IE [ ] Fomo
NI 9237 Calibration Procedure 10
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7. Acquire and average 10,000 points of voltage data using the DAQmx
Read VI, as shown in the following table.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxReadAnalogF64 with
the following parameters:

askfchannels in ask out taskHandle: taskHandle
L s numSampsPerChan: -1
Frmeot] = timeout: 10.0
T DA : fillMode:
E's'? DAQmx_Val_GroupByChannel
Frar in Analog 10 DEL _ rrnfur ok readAt:ray: data .
ik 1Chan MSamp e | arraySizeInSamples: 10000

sampsPerChanRead: sread
reserved: NULL

8. Take a reading of the excitation value from the DMM. You must take
this reading for each excitation value that you enter in step 4.

9. Calculate the upper and lower limits using the following equations:

UpperLimit = (CalibratorOutputSetting | DMMReading) +
AbsoluteErrorfromTable4

LowerLimit = (CalibratorOutputSetting | DMMReading) —
AbsoluteErrorfromTable4

10. Compare the result from step 7 to the upper limit and lower limit
values you calculated in step 9. If the result is between these values, the
device passes the test.

11. Clear the acquisition using the DAQmx Clear Task VI, as shown in the
following table.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxClearTask with the
following parameter:

taskHandle: taskHandle
peeenn] s B P © |

12. Repeat steps 2 through 11 for all voltage values, all excitation values,
and all channels.

13. Disconnect the calibrator and the DMM from the device.
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Specifications

The values in the following table are based on calibrated scaling
coefficients, which are stored in the onboard EEPROM. The following
calibration specifications are for 23 +10 °C.

Table 3. NI 9237 Accuracy

Excitation Setting Value (V) Gain Error Offset Error (LV/V)
2.5 0.14% 325
33 0.12% 10
5.0 0.14% 27.5
10.0 0.16% 45

Test Limits

Table 4 lists the specifications that the NI 9237 should meet if it has been
one year between calibrations.

Using the Table

The following definitions describe how to use the information from
Table 4.

Excitation Setting Value

The Excitation Setting Value is the voltage value to enter in the DAQmx
Create Virtual Channel VI in step 4.

Calibrator Output

The Calibrator Output is the voltage value that you source into the NI 9237
for verification purposes. This value is broken down into two
columns—Location and Value. Location refers to where the value fits
within the test range. Value refers to the voltage value to be verified. Max
refers to maximum value, Min refers to minimum value, and Mid refers to
mid-scale.

Range

The Range is the minimum and maximum voltage range of the input signal.

NI 9237 Calibration Procedure 12 ni.com



Test Point Value

The Test Point Value is an approximate voltage value that the NI 9237
should read given the corresponding calibrator output and excitation
setting.

1-Year Absolute Error

The I-Year Absolute Error is the voltage value that you use to calculate
upper and lower limits.

Table 4. NI 9237 Verification Test Limits

Calibrator Output Range (V/V) 1-Year
Excitation Test Point | Absolute

Setting Value Error

Value (V) Location Value (V) | Minimum | Maximum (V/IV) (V/IV)
2.5 Max 0.055 -0.025 0.025 0.022000 0.000063
25 Mid 0.000 -0.025 0.025 0.000000 0.000033
25 Min -0.055 -0.025 0.025 -0.022000 | 0.000063
33 Max 0.073 -0.025 0.025 0.022000 0.000036
33 Mid 0.000 -0.025 0.025 0.000000 0.000010
33 Min -0.073 -0.025 0.025 —-0.022000 | 0.000036
5.0 Max 0.110 -0.025 0.025 0.022000 0.000058
5.0 Mid 0.000 -0.025 0.025 0.000000 0.000028
5.0 Min -0.110 -0.025 0.025 -0.022000 | 0.000058
10.0 Max 0.220 -0.025 0.025 0.022000 0.000080
10.0 Mid 0.000 -0.025 0.025 0.000000 0.000045
10.0 Min -0.220 -0.025 0.025 —-0.022000 | 0.000080
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Where to Go for Support

The National Instruments Web site is your complete resource for technical
support. At ni.com/support you have access to everything from
troubleshooting and application development self-help resources to email
and phone assistance from NI Application Engineers.

National Instruments corporate headquarters is located at

11500 North Mopac Expressway, Austin, Texas, 78759-3504.

National Instruments also has offices located around the world to help
address your support needs. For telephone support in the United States,
create your service request at ni . com/support and follow the calling
instructions or dial 512 795 8248. For telephone support outside the United
States, contact your local branch office:

Australia 1800 300 800, Austria 43 662 457990-0,

Belgium 32 (0) 2 757 0020, Brazil 55 11 3262 3599,

Canada 800 433 3488, China 86 21 5050 9800,

Czech Republic 420 224 235 774, Denmark 45 45 76 26 00,

Finland 385 (0) 9 725 72511, France 01 57 66 24 24,

Germany 49 89 7413130, India 91 80 41190000, Israel 972 3 6393737,
Italy 39 02 413091, Japan 81 3 5472 2970, Korea 82 02 3451 3400,
Lebanon 961 (0) 1 33 28 28, Malaysia 1800 887710,

Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466,

New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60,

Poland 48 22 3390150, Portugal 351 210 311 210, Russia 7 495 783 6851,
Singapore 1800 226 5886, Slovenia 386 3 425 42 00,

South Africa 27 0 11 805 8197, Spain 34 91 640 0085,

Sweden 46 (0) 8 587 895 00, Switzerland 41 56 2005151,

Taiwan 886 02 2377 2222, Thailand 662 278 6777,

Turkey 90 212 279 3031, United Kingdom 44 (0) 1635 523545

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents . txt file on your CD, or
ni.com/patents.

© 2007 National Instruments Corporation. All rights reserved. 372251A-01 Jun07
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